How to Create Custom Name Badge Inserts
with a Mail Merge in Microsoft Word 2007
Many people know that you can use the Mail Merge feature in Microsoft Word 2007 to easily
create mailing labels, but did you know you can use it to quickly create custom name badge
inserts?
Here, you will learn the steps to create custom name badges with the Mail Merge feature. There
are five basic steps to creating the custom badges:
1.

Set up the name badge list. This is the file that contains all names for people that will
have a printed badge. Many find it easiest to create this file using Microsoft Excel or
Access.

2.

Start your Mail Merge document. In this step, you will begin the process of creating
your Mail Merge.

3.

Link the Mail Merge file to your name badge list. Your names list is the data source
from which MS Word will be pulled directly from MS Excel, MS Access or other data
file during the Mail Merge.

4.

Select a layout for your name badges. It is important to set up a good layout for your
name badges. Once you get one badge layout created, it is easy to carry that style over to
all other badges and complete the Merge.

5.

Preview and complete the Merge and print your badges. You will be able to preview
each insert before you print the entire set.

Below are more detailed instructions for completing each of the basic steps outlined above.

Set Up the Name Badge List
The way to make the Mail Merge process as easy as possible is to first begin with a good set of
data. For many people, this is a list of names created in MS Excel or MS Access.
Make sure that all information that will be included on the name badges is in the spreadsheet.
You can make some changes during the Merge, but you will not be able to open your data source
separately during the merge. The merge process is easier if your data source is ready before you
connect to it.
Give all data fields the proper column headings at the top. This will make it easier during the
merge process because of the way MS Word reads your data file.
Remember to separate each individual data field into separate columns, as shown in the table on
the next page. For instance, if you are going to have an attendees’ first and last name appear on
different lines on the badge, make sure the first and last name are in separate columns in your
spreadsheet. This will make the merge process easier.
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Once you have the data spreadsheet set and finalized, Save it to your computer or system
network. Remember where it is located. You will need to navigate to that place during the
merge.

Start your Mail Merge document
1. First, open Microsoft Word and start a new document.
2. Click on the Mailings tab to start your Mail Merge.
3. If this is your first time performing a
Mail Merge, it is best to use the Step
by Step Mail Merge Wizard, which
will walk you through the process.
4. To do that, locate the Start Mail
Merge button in the Mailings tab.
Click Start Mail Merge, and then click
Step by Step Mail Merge Wizard.
This will open the Mail Merge Wizard
control panel on the right-hand side of
your screen.
5. In Step 1, you will need to select the
document type. For badge inserts, click
Labels. Next, at the bottom of the wizard
panel, select Next: Starting Document,
which will take you to Step 2.
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6. In Step 2, you will select your starting document. Click Change Document Layout, then
select Label Options.
a. A popup box will appear, where you can select the name badge insert you have. C-Line
has preloaded product templates in MS Word. Make sure your Label Vendors menu says
C-Line Products, Inc. In the Product number list, select the insert name or product
number.

For quick reference, the two most common size name badges C-Line sells are
3 ½ x 2 ¼ (insert number LBI35) and 4 x 3 (insert number LBI43).
b. After you select the insert you are using, click OK. MS Word will automatically create
the badge insert layout grid, using a table. If you are not able to see the lines that separate
the inserts, click the Layout tab under Table Tools. Then, in the Table box (far left
side), click View Gridlines.

c. Click Next: Select Recipients at the bottom of the wizard panel to move to Step 3.
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Link the Mail Merge File to Your Name Badge List
In Step 3, you will connect your merge file to your list of names for the badges, which is known
as the data source. Most people will use a MS Excel worksheet, MS Access database or other
data file.
1. Make sure Use an Existing List is selected at the top of the wizard control panel, then click
Browse. A popup box will appear which will allow you to navigate to your data source. Once
you find it, click on the file, and then click the Open button.

For MS Excel, you will data will come from a worksheet or specified range within your
workbook. If your workbook contains several worksheets, you will need to select the
proper one. Most people have their data entered in the first worksheet, typically title
"Sheet1", which is the default name in Excel.
For MS Access, you will need to select which table or query your data will be pulled
from within a specified database.
2. If you plan to use all names in your list, click OK. You are then ready to proceed with to the
next section, where you will determine the badge layout.
a. If you need to refine the list of names, you can do that right now, without having to
directly alter your data source. In the wizard control panel, click Edit Recipient List. In
the Mail Merge Recipients popup box, you will now be able to:
i. Select individual names. Simply select or clear the checkboxes in front of each
name to include or exclude them from the Merge. If you want to include only a
few of the names, it is easiest to uncheck all boxes and then go back and check
only the names you need.
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ii. Sort names. Click the column heading of the item that you want to sort by.
The list sorts in ascending alphabetical order (from A to Z). Click the column
heading again to sort the list in descending alphabetical order (Z to A).
iii. Add names. To add names or information to your data source file, click on the
name of your data file, which will be displayed in the white Data Source box.
Next click Edit, which will bring up an Edit Data Source popup box. Click New
Entry, and type the new information for that person.
iv. When you have the data source edited to the way you want it, click OK.

3. You are now reading to arrange the layout for the badges. Click Next: Arrange Your Labels
at the bottom of the wizard control panel to move to Step 4.

Select a Layout for Your Name Badges
Step 4 is where you will arrange the layout for the badges.
1. First, determine the horizontal and vertical alignment you would like for all of your badges;
center justification is recommended for name badges. Once you know that information, follow
these steps to set the alignment for all badge cells:
a. Highlight all cells by clicking small box located in the upper left-hand portion of the
page (when you hover over it, the cursor arrow will change to a cross) and left-click; all
badge cells will now be highlighted.
b. Next, click the Table Layout tab.
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c. Select the cell alignment you would like to use from the options in the Alignment box,
which include Upper Left, Upper Center, Upper Right, Middle Left, Middle Center,
Middle Right, Lower Left, Lower Center and Lower Right.
2. With the cursor in the first cell, begin to add Mail Merge Fields to the insert. Mail Merge
Fields act as placeholders for text that will later be merged in the file. The field names
correspond with the column headings from your data source. You can view all available Mail
Merge Fields by clicking More Items in the wizard panel.
3. Begin to insert Mail Merge Fields by clicking
them from the Insert Merge Field popup box.
When you insert a mail merge field into the Merge
document, the field name is always surrounded by
chevrons (« »). These chevrons do not show up on
the final badges. They are there to help distinguish
the Mail Merge fields from any other text you type
into the document.
Be sure to add line breaks and returns where you
would like them. For instance, a line break has
been added between «First_Name» and
«Last_Name» in the example pictured to the right.
4. Type any additional text or insert any images
that you will want to be repeated on each label, such as a company logo, meeting artwork or
conference name.
5. To add clip art, a picture or logo, click on the Insert tab and located the Illustrations area.
a. To insert clip art, click the Clip Art icon. A side box will appear. From there, search
for the appropriate image and Insert it into the cell. Resize the image if necessary.
b. To insert a picture, logo or other graphic file saved on your computer, click the Picture
icon. A popup box will appear. From there, navigate to where the image file is saved in
your folders and click to add it to document. Resize the image if necessary.
6. Once the image has been inserted into the first badge cell, you will need to align it within the
cell. There many ways to do so, but we've found the following steps to be the easiest:
a. Click on the image. Select Format in the Picture Tools tab (this will be highlighted in
red/pink at the top of your screen).
b. Change the Text Wrap setting to Tight. The default setting will be In Line with Text.
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c. While the image is still clicked on and the text wrapping changed, click through the
nine default Position options. Many times, one of these options will where the image is
wanted.
d. If none of the nine placement positions work with the badge layout you want, select
More Layout Options in the Positions menu. This will open the Layout popup box. To
have the image placed exactly where you want it on the badge, we recommend selecting
an Absolute Position for the horizontal and vertical positioning. This will ensure the
image remains in the same location for all badges throughout the Mail Merge process.
7. Now that you have all text and images aligned inside the first cell, it is time to change the font
type, size and color. In the Home tab is a section named Font. This is where you can change the
font type, the size of the font, and the color of the font. Simply highlight the portions of text with
the cursor that you would like to change and alter the font appearance as you like.
8. With the first cell arranged how you want it, click the Update All Labels button in the wizard
control panel. All cells will automatically update with the Mail Merge Fields and any added text
or images.

When Update All Labels is clicked, the layout of all subsequent cells will look distorted because
of the text length of the Mail Merge Field names. Do not worry; this distortion and line wrapping
will not carryover to your final document.
With the layout of your badges set, you are almost finished with the Mail Merge. Click Next:
Preview Your Labels to preview your badges and complete the Merge.
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Preview and Complete the Merge and Print Your Badges
In Step 5 of the Mail Merge, you will be able to preview how the badges will look with your
data. This step can be used to see how the information look before it is finalized and alter the
layout, if necessary.
1. When you are satisfied with the preview, you can complete the Mail Merge. At the bottom of
the wizard control panel, click Next: Complete the Merge.

2. In Step 6, you can now complete your Mail Merge and either Print your badges or Edit the
Individual Labels.

a. If you are happy with how the preview looked, click Print. You can choose if you
would like to print an individual badge or the entire group. Either option will bring up
your Printer window. You can now print your badge inserts.
b. If you decide to Edit Individual Labels, all merged inserts will be brought up in a
new document. You can save the file for future use or reference from here. After you
finish editing the new document of badge inserts, you are now ready to print your badge
inserts.
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3. Once all inserts are printed, remember to Save the mail merge document, for your records or
future use.
4. When you Save the Mail Merge document, you also save the connection to your data file. The
next time you open this file, you will be asked to choose whether you want to information to be
merged again.
a. By clicking Yes, the document will open with the information from the first record
merged in.
b. By clicking No, the link between the Mail Merge file and the data file will be broken.

Congratulations, you have completed a Mail Merge and created your
Custom Name Badges Inserts!

FAQs and Troubleshooting Tips
Q:

When should I do a Mail Merge to make name badges versus downloading a template
from your website?

A:

If you will be making more than one sheet of name badges, we recommend you perform
a Mail Merge. When manually typing information using a blank template, the page
spacing will slightly shift every time you add a new page. This means, the information on
the badge inserts will not be in the correct area on the pages following the first sheet.
However, Microsoft Word will automatically add the correct spacing between pages
when using a Mail Merge.

Q:

I am not able to complete the Merge right now. Can I save the file from where I am? Or
do I have to close out of the file and start over at a later date?

A:

You do not have to start over from the beginning if you cannot complete the Merge
process in one sitting. If you need to stop working in the Merge file before you have
completed the process, simply Save the main document. MS Word will retain the
connection to your data file and the fields being used in the Merge. When you open the
file at a later time, you will receive a message asking you to confirm if you would like to
open the document. Because this file is connected to your data file, click Yes. The text of
the document, along with any fields that you inserted, will appear. Click on the Mailings
tab to resume the Merge.
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Q:

I am not able to edit the data source from MS Word once I connect it to Merge document.
Why?

A:

Depending on the type of data source you are using, some functions may not be available,
which is why it is recommended that your data file be as complete as possible before you
connect it to your Merge document.

Q:

There is an extra space at the end of each insert which preventing my data from being
centered vertically. How can I fix this?

A:

If the inserts have an extra line at the end of each badge, click on the Paragraph icon (¶)
while in the Home tab. This will display all the places where a paragraph line break is in
the document. If there is a paragraph symbol at the end of the badge, this will add an
extra line at the bottom of the badge. To remove this line, simply delete the last paragraph
symbol, and update all records.

Q:

I like the text layout in my first badge, but not for the rest of the badges on the page. Why
didn’t all formatting carry over when I click Update All Labels in Step 4?

A:

While clicking that button does update the data fields for each inserts, it will not change
the text layout. This needs to be done manually by you, during Step 4.
For instance, the default alignment for each insert has the text beginning in the upper lefthand corner. If you want the text centered in the badge, highlight all cells with your
cursor. While the cells are still highlighted, click the Table Layout tab and chose the text
alignment you would like to use from the options in the Alignment box.
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